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Summary
This note describes installation of Windows NT 4.0 Workstation on a stand alone PC, e.g. on your
PC at home. It draws on my experience with the introduction of Windows NT in section Biophysics
and thus clearly shows signs thereof.
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1. Introduction
Windows NT is a multi-tasking operating system with a graphical user interface. It has the
following important characteristics.

• Separation use – system administration

• Support for multiple users, where each user has her own working environment

• NT File System (NTFS) offering file protection and support for large disks

To access a Windows NT computer, you are required to logon and authenticate yourself.
Depending on the account you logon to, you become a User or a system Administrator.

Installing and configuring Windows NT must be done as an Administrator. Normal use should be
done as a User, as to protect the installation from accidental mistakes. As a user you are able to
configure (part of) your working environment.

To simplify matters a Windows NT-only installation is described. So choosing from more than one
operating system when starting the computer  – multi-booting – is not handled. Also not handled is
the NTFS security system. No indications are given as to why or how to set or change a file or
folder’s security setting.

The Operating System and Applications described here, are all English versions.

2. Installing the Operating System
Installing Windows NT is divided into the following steps.

• Preparation

• Installing Windows NT 4.0 Workstation

• Installing Video Driver

• Installing Mouse Driver

• Installing Printer Driver

• Installing Modem Driver and Networking

• Installing Required Patches

2.1. Preparation
First, we must be able to start the computer, either directly from the Windows NT CD, or from
three Windows NT Setup floppies.

Set BIOS to Start from CD-ROM (Award BIOS)
• Press the reset button to restart the computer

• Press the Del-key while the computer is restarting to enter the BIOS setup

• In the BIOS setup select BIOS Features Setup

• For Boot Sequence, select : CDROM,C,A

• Press Esc-key to enter the main page again

• select Save & Exit Setup and press Enter

• Answer Y to Save to CMOS and Exit (Y/N)?

If it is not possible to set the BIOS to start from CD-ROM, you should use the three Windows NT
4.0 Workstation Setup floppies (See B. How to Create the Windows NT Setup Floppies.).
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In this case, make sure the BIOS is set to start from the floppy drive. Use a procedure similar to
Set BIOS to Start from CD-ROM to check or set this.

2.2. Windows NT 4.0 Workstation
Now we are ready to begin the installation of Windows NT itself. Either start the computer from the
Windows NT CD, or start it from the Windows NT Setup floppy #1.

Start from Windows NT CD
• Insert the Windows NT CD in the CD-ROM drive

• Press the reset button to restart the computer from the CD and begin Windows NT Setup.

Or

Start from Windows NT Setup floppies
• Insert the Windows NT CD in the CD-ROM drive

• Insert the Windows NT 4.0 Workstation Setup floppy #1 in drive A:

• Press the reset button to restart the computer from floppy #1
supply floppy #2 when requested
continue Windows NT Setup.

Windows NT Setup
• Press Enter to automatically detect disks

(when requested, supply floppy #3)

• Press Enter to Continue (no additional devices specified)
(A warning about the inability to access the complete harddisk may appear)

• Agree to License Agreement (13 x PgDn, F8)

• Press Enter to accept the list of hardware/software components

• Press C to create a partition in unpartitioned space to install Windows NT on
Optionally delete one or more existing partitions
Create partition of size (in MB): 4000
Press Enter to create the partition

• Press Enter to install

• Select: Format the partition using the NTFS file system,
Press Enter to continue,
Press C to confirm conversion to NTFS
(file system is converted from FAT to NTFS later on)

• Press Enter to accept the location to install: \WINNT

• Press Enter to examine disk C

• Setup copies files...

• Remove floppy from drive (if any)
Remove CD-ROM from drive
Press Enter to restart
(File system is converted from FAT to NTFS now, system restarts again)

• Graphical part of Setup begins

• Please insert the Compact Disc ‘labeled Windows NT Workstation CD-ROM’, Press Ok
Setup copies files...
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Gathering information about your computer
• Press Next to continue

• Select Typical for Setup Options

• Specify Name and Organization: Name, Organization

• Specify Computer Name: Name

• Specify Administrator Account password (initial, may be left blank): password

• Create Emergency Repair Disk (default)

• Select Components (default)

Installing Windows NT networking
• Select ‘Do not connect this computer to a network at this time’

In doing so, we get Windows NT running a little earlier and obtain the same procedure for
adding a modem now and later on.

Finishing Setup
• Press Finish to continue

• Time Zone: select Paris, Madrid, Amsterdam, press Close

• Detected Display: found vga compatible display adapter, Press Ok, Press Ok

• Copying Files...
Setting security on system files...
Saving configuration...

• Press Enter to Create Emergency Repair Disk: Formatting, Copying Files

• Remove CD-ROM, floppy disk, press Enter to restart the computer

Set BIOS to start from C (Award BIOS)
• Press the Del-key while the computer is restarting to enter the BIOS setup

• In the BIOS setup select BIOS Features Setup

• For Boot Sequence, select: C,A or C Only

• Press Esc-key to enter the main page again

• Select Save & Exit Setup and press Enter

• Answer Y to Save to CMOS and Exit (Y/N)?

2.3. Windows NT Logon

After another restart, the Windows NT opening screen appears. The following procedure can be
used to logon as an Administrator when required.

Press the Ctrl+Alt+Del keys simultaneously to get the Logon Information box. Enter the
Administrator password – if you specified one during setup – and press Enter to logon.

Press Close to close the Welcome to Windows NT box.

2.4. Video
Now we are ready to install the specific driver for the video card the computer has. Here is the

procedure for a Matrox G400 Video Card. It probably is very similar for other video cards.
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Install Video Driver
• Insert the Matrox Installation CD into the CD-ROM drive

The installation program starts automatically; if it does not, you can start it as follows:
Start | Run, Browse: D:\mgasetup

• Press Next to accept English

• Press Next to continue (optionally view Readme)

• Press Install to do the First Time installation

• Press Enter to accept Typical Setup
copying files…

• Press Next to continue Setup

• Press Ok to restart the computer
computer restarts…
Logon again as Administrator again
(Uncheck Show Tip at Logon, press Close to close box)

• Select Acrobat Reader 3.01 (8.0 MB)
Select Matrox PowerDesk Online documentation (2.2 MB)
Select Matrox System Utilities (1.50 MB)
Press Enter to install

• Press Next to continue

• Press Next to accept Destination Location (C:\Matrox\util)

• Press Enter to Finish Setup

• Press Exit to leave Matrox Setup

Setup Video Mode
• Press Enter to Continue (Invalid Display Settings)

• Now set the video mode on the Display Properties:
Select True Color for Color Palette
Slide the Desktop Area to 1024 by 768 pixels
Select 75 Hz for Refresh Frequency

• Press Test, Ok to preview the result and wait for the test screen to disappear again

• Press Yes to confirm proper display of test screen

• Press Ok to accept the new Display Properties.

The new screen setup appears and you can adjust the monitor settings now to get a nice picture.

2.5. Mouse
Install and configure the driver for the mouse. Here is an example for the Logitech Pilot Mouse
(Software version 8.20).

Install Mouse Driver
• Insert floppy #1 into drive A:

• Start | Run: A:\Setup.exe

• Press Enter to accept English

• Press Enter to accept Express Setup

• Insert Disk #2 when requested, press Enter to continue
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• Press Enter to Finish and restart the computer

• Remove the diskette from drive A:, press Enter to continue

Configure Mouse Driver
• Logon as Administrator again

A New Device message box appears

• Press Enter to configure the mouse

• Press Enter to continue Device Setup Wizard

• Press Enter to accept ‘The mouse is placed on the Right side of the keyboard’ (default)

• Select Other: Double-Click for function for the middle button, press Enter to continue

• Press Enter to Finish setup

• Uncheck the box at the lower right: ‘Show icon in the taskbar’

• Press OK to terminate Mouse Properties dialog box

• Close the Logitech MouseWare folder

2.6. Printer
A printer is added directly from the installation procedure supplied by the manufacturer, or through
Add Printer… available via the Start menu. An example for the EPSON Stylus Color 740 ink jet
printer and the more generic procedure follows.

Install EPSON Stylus Color 740
• Insert EPSON Stylus Color 740 CD into CD-ROM drive

The installation program starts

• Click Printer Drivers to select printer drivers section

• Click Windows NT 4.0 to select the proper driver
The EPSON Printer Driver Setup Utility installs the driver

• Press Enter to remove message box ‘Please restart your computer’

• Press Quit to terminate installation program.

• Press Ctrl+Alt+Del to enter the Windows NT Security box

• Press Shut Down…
Select Shutdown and Restart
Press Enter to restart the computer.

Generic Install Printer Driver
• Open Printers from the Start menu: Start | Printers

• Double-Click the Add Printer… icon in the Printers folder
The Add Printer Wizard dialog box appears

• Press Enter to accept ‘The printer will be managed by My Computer’

• Press spacebar to check the box LPT1
Press Enter to continue

• Press Have Disk… to install the printer driver from floppy or CD-ROM

• Follow instructions on screen from here
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Provide a Description and Location for the Printer
• Open Printers from the Start menu: Start | Printers

• Double-Click the icon for your printer in the Printers folder

• Select Properties from the Printer menu in the printer control panel
On the Properties Panel supply descriptions for Comment and Location

Set the Document Defaults for the Printer
• Open Printers from the Start menu: Start | Printers

• Double-Click the the icon for your printer in the Printers folder

• Select Document Properties… from the Printer menu in the printer control panel
Here set the properties as you find fit

2.7. Modem and Network
A modem is added through Modems in the Control Panel. Adding an ISDN modem is not covered
here.

Install Modem
• Open the Control Panel: Start | Settings | Control Panel

• Double-Click Modems in the Control Panel
The Install New Modem dialog box appears

• Press Enter to continue and let Windows NT try to detect the modem
Don’t check the box: Don’t detect my modem; I will select it from a list

• From here I don’t know… (I don’t have a modem).

• If Standard Modem is found, specify Change…, and then Have Disk… to install the driver for
your modem

• Install modem on Proper port

• Specify Location Information
country: Netherlands
area (city) code: 071
code to access outside line: (sometimes 0 when dialing via your home/quattro vox etc.)
accept Tone dialing

• Finish

Test Modem
To test if the modem works, you can user the HyperTerminal program to connect to the indy
workstation.

• Start the HyperTerminal program
Start | Programs | Accessoires | Hyperterminal | HyperTerminal

• Specify a name for the Connection Description dialog box: CRI
Press Enter to continue

• Specify the Phone Number in the Connect To dialog box: 071-5278181
Press Enter to continue and make the connection

• Press Enter when the connection is established

• Enter the following command to connect to the indy workstation:
XX>telnet indy.biophys
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• If all is well, you can logon to the indy workstation now

Install Network
• To be determined / Done by Thuisnet 2 Installation Procedure?

2.8. Required Patches
To correct for year 2000 and other problems in the operating system, Internet Explorer 4.01
Service Pack 2 or higher must be installed along with Windows NT 4.0 Service Pack 6a.1

Note: any time software has been installed from the original Windows NT CD, you have to apply
the Windows NT 4.0 Service Pack again. This happens when you add some functionality and
Windows requests for the Windows NT CD. Apply the Service Pack again to be absolutely sure,
no corrected software has been replaced again with a faulty predecessor.

We have to apply Windows NT Service Pack 6a two times because Internet Explorer needs
Windows NT Service Pack 3 or higher and the Service Pack must also be applied after Internet
Explorer has been installed.

Windows NT 4.0 Service Pack 6a, First Time
Install Windows NT 4.0 Service Pack 6a.

• Insert the Y2k r4 CD into the CD-ROM drive

• Start | Run: D:\winnt\sp6ai386.exe

• Check Accept the License Agreement
Uncheck Backup files necessary to uninstall
Press Enter to begin installation
Installing…

• Press Enter to restart the computer

Internet Explorer 4.01 Service Pack 2 or Higher
Install Internet Explorer 4.01 Service Pack 2 and Outlook Express 4.01 SP2 year 2000 update.
Alternatively, you can install Internet Explorer 5 (D:\apps\ie5\winnt\ie5setup.exe).

• Insert the Y2k r4 CD into the CD-ROM drive

• Start | Run: D:\apps\ie401sp2\winnt\ie4setup.exe

• Active Setup screen appears
Press Enter to continue

• Select I accept the agreement and press Enter to continue

• Press Enter to accept standard installation

• Press Enter to accept default Destination Location
(C:\Program Files\Plus!\Microsoft Internet)

• Preparing Setup…
Installing…

• Setup has finished installing components
Press Enter to start configuring

• Press Enter to restart the computer

                                                     
1 Yes, this indicates Internet Explorer is interwoven with the operating system.
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Outlook Express 4.01 SP2 year 2000 update
• Start | Run: D:\apps\ie401sp2\outlook\en-x86-Q234680.exe

Windows NT 4.0 Service Pack 6a, Second Time
Install Windows NT 4.0 Service Pack 6a for the second time. See above.

2.9. Some Configuration
Now we do some configuration on Windows NT.

Configure Startup/Shutdown
When the computer starts, the list to choose between Windows NT Workstation 4.00 and
Windows NT Workstation 4.00 [VGA mode] is shown for quite a long time provided you don’t
press Enter to accept the default. Here we decrease this time to five seconds.

• Right Click on the My Computer icon and select Properties to open System Properties

• Specify 5 seconds for ‘Show list for … seconds’

• Press Enter to accept settings

Regional Settings
Here we configure some regional settings, notably currency and time representation and optionally
support for other languages (the input locale).

• Open control panel: Start | Settings | Control Panel

• Double-Click the Regional Settings icon to open it

• On the Regional Settings Tab:
Select English (United Kingdom)

• On the Currency Tab:
For Currency symbol: select Euro

• On the Time Tab
Time style: HH:mm:ss (default)

• On the Date Tab
Short date style: dd/MM/yy (14/01/00) (default)
Long date style: dd MMM yyyy (14 January 2000) (default)

• On the Input Locales Tab: (for keyboard layout)
English (United States)
You may want to add support for another language (requires Windows NT CD)
Input Locale can be selected via Start | Settings | Control Panel | Keyboard, or via Input Locale
icon on the taskbar if it’s enabled

• Press Enter to accept settings and remove Regional Settings dialog box

Remove Inbox and Internet Explorer Icons from Desktop
• Right-Click on the Inbox icon on the desktop and select Delete

Press Yes (Enter) to confirm the deletion.

• Right-Click on the Internet Explorer icon on the desktop and select Delete
Press Yes (Enter) to confirm the deletion.

• Right-Click on the Outlook Express icon on the desktop and select Delete
Press Yes (Enter) to confirm the deletion.
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Set My Computer and Network Neighborhood Options
• Double-Click My Computer

• Select Toolbar from the View menu

• Select Options from the View menu

• On the Folder Tab
( ) Browse folders using a separate window for each folder.
(•) Browse folders by using a single window that changes as you open each folder.

• On the View Tab:
(•) Show all files
( ) Hide files of these types
[X] Display the full path in the title bar
[ ] Hide file extensions for known file types
[X] Display compressed files and folders with alternate color

• Press Enter to accept these settings

• Repeat these steps for Network Neighborhood

Set Windows NT Explorer Options
• Start the Windows NT Explorer: Start | Programs | Windows NT Explorer

• Select Toolbar from the View menu

• Select Options from the View menu

• On the View Tab:
(•) Show all files
( ) Hide files of these types
[X] Display the full path in the title bar
[ ] Hide file extensions for known file types
[X] Display compressed files and folders with alternate color
[X] Include descriptions bar for right and left panes

• Press Enter to accept these settings

3. Working with Partitions
Because the initial Windows NT installation starts with a FAT partition, maximum partition size is
about 2 Gbyte (partition created with fdisk) or 4 Gbyte (partition created by Windows NT Setup).
With current disks as large as 13 Gbyte, you may want to resize the Windows NT partition after
installation. Note however that for the Windows NT installation at Biophysics, drive C: only uses
about 1.5 Gbyte of the 4 Gbyte availabe, so a partition of 4 Gbyte might be fine. Section 3.1
describes how you can change the partition size using Partition Magic 4.0 from PowerQuest.

Further it’s a good idea to create a separate partition for users’ files. This clearly separates user
information from operating system and application components. See section 3.2 to create a user
partition and drive on it.

3.1. Resizing the Windows NT Partition
This section describes how you can repartition the Windows NT partition with Partition Magic 4.0
from PowerQuest.

• Start computer with Partition Magic floppy
Make sure computer starts from drive A:

• Run Partition Magic: A:\>pqmagic
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The PartitionMagic 4.0 by PowerQuest screen appears
An overview of the partitions is presented

• Select Resize/Move… from the Operations menu

• In the Resize/Move Partition dialog box, specify the new size (e.g.):
New Size: 6000

• Press Enter to accept the new partition size

• Press Apply on the main screen to accept the changes
Press Enter to confirm to Apply changes now

• Repartitioning starts and the Batch Progress window appears.
Press Enter to remove Batch Process progress window, when processing is completed

• Press Exit to leave Partition Magic program

• Remove floppy from drive A:

• Press Reset button to restart the computer

3.2. Creating the User Partition and Drive
This section describes how you can create a separate drive for user files.

To this end we use Disk Administrator to assign letter E: to the CD-ROM drive and partition and
format drive D: with the NTFS file system, labeled People.

• Start the Disk Administrator:
Start | Programs | Administrative Tools (Common) | Disk Administrator

• A message appears telling it’s the first time Disk Administrator has been run, etc.
Press Enter to continue

• A message appears about No signature found on Disk 0.
(only after repartition of Windows NT partition?)
Press Enter to confirm

• Disk Administrator screen appears

• Right-Click on the area for Drive D: (CD-ROM)
Select Assign Drive Letter … from the context menu
Select drive E: on the Assign Drive Letter dialog box
Press Enter to accept this setting
Press Yes to confirm the warning message

• Right-Click on the Free Space right to Partition of Drive C:
Select Create… from the context menu
Press Yes to confirm the warning message

• Accept or specify the partition size on the Create Primary Partition dialog box
Press Enter to accept the partition size

• Press Yes to confirm the warning message and create the partition

• The partition is displayed as drive D:

• Right-Click on the area for Drive D:
Select Commit Changes Now…
Press Yes to confirm the warning message
Press Enter to confirm the warning message

• Right-Click on the area for Drive D:
Select Format…
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• On the Format D:\ dialog box:
Select File System: NTFS
Specify Volume Label: People
Press Enter to start formatting
Press Enter to confirm the warning message
Wait for the Format Complete message
Press Enter to confirm
Press Esc to remove Format D:\ dialog box

• Select Exit from the Partition menu to leave Disk Administrator

4. Installing Applications
We install applications using default directories, default program group. In some cases the
program group has to be moved from the Administrator Profile to the All Users Profile. For some
applications and the MS Office 97 suite, a program group has to be created.

The installation program for many applications puts icons on the desktop and in the system tray
on the right part of the taskbar. I don’t like this overwhelming number of icons and generally I
remove them.

Often after installation of a program, the computer must be restarted before the application can be
used. In this description the computer is always restarted when the installation program indicates
that this is necessary. However it is very well possible to refrain from restarting the computer,
continue with the installation of other programs and restart the computer later on.

4.1. VirusScan NT
• Insert the Y2k r4 CD into the CD-ROM drive

• Start | Run: E:\apps\vscan\winnt\intel\setup.exe
The Welcome screen appears
Press Enter to continue

• Press Enter to accept the Software License

• Press Enter to accept Local Installation

• Press Enter to accept Typical Installation Type

• The Service Account Usage screen appears
Press Enter to continue
Select Use the SYSTEM account
Press Enter to accept this setting and continue

• Press Enter to confirm the Installation Settings
installing…

• Press No to skip viewing latest information

• Press Enter to restart the computer now

4.2. WinZip
WinZip is a file archiving and compression program.

• Insert the Biophysics Proto CD into the CD-ROM drive

• Start | Run: E:\winzip\winzip70.exe

• Press Enter to start Setup

• Press Enter to accept the installation directory



Installing Windows NT 4.0 Workstation at Home 28 February, 2000 13

(C:\Program Files\WinZip)

• Winsock Setup screen appears

• Press Enter to continue Setup

• Press Yes to accept the License Agreement

• Select Start with WinZip Classic, Press Enter to continue

• Press Enter to accept Express Setup

• Press Enter to Finish Setup

• Press Enter to close the Tip of the Day screen

• Close WinZip and the WinZip All Users Profile folder

Remove WinZip shortcut from Administrator Profile
• Right-Click the Start button on the taskbar to open the context menu,

Select Explore All Users

• Select the Start menu folder of the Administrator Profile in the All folders pane at the left
(C:\Winnt\Profiles\Administrator\Start Menu)

• In the Contents of pane at the right:
Right-Click WinZip to open the context menu
Select Delete
Press Enter to accept deletion

4.3. Winsock FTP
Winsock FTP is a program with a graphical user interface to do file transfer using the File Transfer
Protocol.

Install Winsock FTP
• Insert the Biophysics Proto CD into the CD-ROM drive

• Open a Windows NT Explorer: Start | Programs | Windows NT Explorer

• Double-Click: E:\ws_ftp\ws_ftp32.zip
Press I Agree to accept WinZip license agreement

• Press Extract
Specify the Extract to folder: C:\Program Files\Winsock FTP

• Press Enter to Extract the files

• Close WinZip

Create Start Menu Folder in All Users Section
• Right-Click the Start button on the taskbar to open the context menu,

Select Explore All Users

• Select the Programs folder of the All Users Profile in the All folders pane at the left
(C:\Winnt\Profiles\All Users\Start Menu\Programs)

• Right-Click in the Contents of ‘Programs’ pane at the right to open the context menu
Select New ► Folder
Specify the folder’s name: Winsock FTP
Press Enter to accept the new name

• Now in the All folders pane at the left:
Select the Winsock FTP folder in the Program Files subdirectory
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(C:\Program Files\Winsock FTP)
The Winsock FTP files are now visible in the right pane

• Left-Click Ws_ftp.hlp
Ctrl+Left-Click Ws_ftp.exe
Right-Click Ws_ftp.exe to open the context menu,
Select Copy

• In the All folder pane at the left scroll to the Winsock FTP folder of the All Users Profile and
select it (C:\Winnt\Profiles\All Users\Start Menu\Programs\Winsock FTP)

• In the right pane Right-Click to open the context menu and select Paste Shortcut

• Rename Shortcut to Ws_ftp.hlp to Online Manual
Rename Shortcut to Ws_ftp.exe to Winsock FTP
(Right-Click file, select Rename and specify new name)

4.4. Diskeeper
Diskeeper is a file defragmentation program. Use it now and then – as an Administrator – to check
for and recover from file fragmentation, or set it to automatically keep fragmentation low.

There’s also a less capable license free version: diskeeper-light (see further).

Install Diskeeper 5.0
• Insert the Diskeeper 5.0 for Windows 95/98/NT CD into the CD-ROM drive

If the installation program does not start automatically, do a Start | Run: E:\Demo32.exe

• Click Install Diskeeper Workstation

• If Diskeeper Setup warns to stop McAfee Anti-Virus, stop it as follows:
Right-Click the VirusScan icon in the system tray on the taskbar to open the context menu
Select Disable
Press Ok on the Diskeeper window to continue

• Press No to refrain from upgrading to Internet Explorer 5.0

• Press Enter to confirm the Required Software Check message
Installing required software
Press Enter to confirm the setup completed installing required software message

• Press Enter to confirm the Welcome message

• Press Enter to accept the Software License Agreement

• Press Enter to accept the default Destination Location
(C:\Program Files\Executive Software\DiskeeperWks)

• Press Enter to accept the default Program Folder
(.\Executive Software\DiskeeperWorkstation)

• Installing required software

• Press Cancel to skip registering
Press Never Register to continue

• Press Enter to accept default Diskeeper Frag Guard settings

• Press Enter to Finish installation and restart computer now

Or
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Install Diskeeper Light
Diskeeper Light is a license free file defragmentation program. Use it now and then to check for
and recover from file fragmentation. You should use it as an Administrator.

• Insert the Biophysics Proto CD into the CD-ROM drive

• Start | Programs | Windows NT Explorer

• Double-Click: E:\Diskeeper-light\DkL11174auk_i.zip

• Press I Agree to accept WinZip license

• Press Install

• Press Enter to confirm message

• Diskeeper installation starts

• Press Enter to continue
Press Enter to continue

• Press Enter to accept License Agreement

• Press Enter to accept Destination Location
(C:\ExecSoft\DkLite)

• Installing…

• Press Enter to confirm message

• Press Enter to confirm message

• Press WinZip on the taskbar (minimized)

• Press Enter to return to WinZip

• Close WinZip

4.5. Netscape Communicator
Install Netscape 4.7 from the Y2k r4 CD. To create a Netscape User Profile, see the document
Configuring Netscape 4.5 at Biophysics.

• Insert the Y2k r4 CD into the CD-ROM drive

• Start | Run: E:\apps\ns47\cc32e47.exe

• Custom install (all components)
Press Enter to continue Netscape Communicator 4.7 Setup

• Press Enter to accept Software License Agreement

• Press Enter to accept Typical Setup Type and installation directory

• Press Enter to accept Netscape Desktop Preference Options

• Press Enter to accept default Program Folder
(C:\Program Files\Netscape\Communicator)

• Press Enter to start installation
Wait for installation to complete

• Press No to skip viewing Readme file

• Press Enter to remove message box

• Press Enter to restart the computer
You may however also delay restarting the computer and continue with the following item, as
long as you restart the computer before using Netscape Communicator.



16 28 February, 2000 Installing Windows NT 4.0 Workstation at Home

After the system restarts, we change the Communicator shortcuts to use the specific Netscape
User Profile for the user that’s logged on. We do this by adding -P”%USERNAME%” to the Target
of the shortcuts to the Netscape Communicator programs.

• Open the All Users Start Menu section:

• Right-Click the Start button on the taskbar to open the context menu, select Explore All Users
and enter the Netscape Communicator folder in the Program folder

or

Alternatively use the Netscape Communicator Folder that the Netscape installation put on the
desktop.

• Right-Click the Netscape Composer icon and select Properties
Select Shortcut Tab
Change Target to: ...netscape.exe" -edit -P"%USERNAME%"

• Right-Click the Netscape Messenger icon and select Properties
Select Shortcut Tab
Change Target to:...netscape.exe" -mail -P"%USERNAME%"

• Right-Click the Netscape Navigator icon and select Properties
Select Shortcut Tab
Change Target to:...netscape.exe" -P"%USERNAME%"
(remove –browser !)

The mail notification program for the icon on the taskbar, nsnotify in the Utilities subdirectory,
cannot be used with parameters to specify a Netscape profile. It uses settings from the time
Netscape last ran.

Remove Netscape SmartUpdate Start Menu Entry
• Open the All Users Start Menu section:

Right-Click the Start button on the taskbar to open the context menu, select Explore All Users

• Select the Start Menu folder for the All Users Profile
(C:\Winnt\Profiles\All Users\Start Menu)

• Select the shortcut named Netscape SmartUpdate and put it in the recycle bin

Remove Icons from Desktop and Taskbar
• Select the following Netscape icons on the desktop and put them in the Recycle Bin:

Netscape Communicator
AOL Instant Messenger (TM)
RealPlayer G2

• Right-Click on the blue RealPlayer icon in the system tray
Select Disable SmartStart
Press Yes (Enter) to accept the removal of it from the system tray

4.6. Adobe Acrobat Reader
Install Adobe Acrobat Reader 4.0. It is done after installation of Netscape Communicator so the
AcroRead Netscape plug-in can be installed.

• Insert the Biophysics Proto CD into the CD-ROM drive

• Start | Run: E:\acroread\ar40eng.exe

• Press Enter to continue Setup
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• Press Enter to accept License Agreement

• Press Enter to accept default Destination Location
(C:\Program Files\Adobe\Acrobat 4)

• Press Enter to Finish installation

• Remove the Acrobat Reader 4.0 icon from the desktop

4.7. Microsoft Office 97
If you have enough hard disk space available, it’s probably a good idea to do a complete
installation of Microsoft Office 97. If you require the Formula editor and/or some text conversion
utilities, you have to do a Complete install or a Custom install and select the required items; a
Typical install does not cover these items.

In addition to Office 97 itself, some language packs can be installed. It is required to install
Office 97 Service Release 2b and two security patches.

When installed, we have to create a folder for Microsoft Office 97 in the All Users section of the
Start Menu.

Microsoft Office 97
• Insert the Office 97 CD into the CD-ROM drive

The Setup program starts automatically

• Press Install Microsoft Office

• Press Enter to confirm the Welcome message and continue

• On the Name and Organization Information screen:
Specify Name: Name
Specify Organization: Organization
Press Enter to accept the information
Press Enter to confirm the information

• Product IE: 63853-270-5101876-02460 ( 63853-270-7327054-14814)
Press Enter to confirm this screen

• Press Enter to accept the default Destination Folder
(C:\Program Files\Microsoft Office)

• Press Custom

• On the Custom screen:
Press Select All (191 MByte)
Press Continue

• On the Select Paper Format and Language screen:
Select A4, US English dictionaries
Press Enter to continue

• Installing…

• Microsoft Office 97 Setup was completed successfully
Press Enter to confirm

• Close the installation program window

Remove Icons from Desktop
• Select the Microsoft Outlook icon on the desktop and put it in the Recycle Bin.

• Select the Setup for Microsoft Internet Explorer 3.02 icon on the desktop and put it in the
Recycle Bin.



18 28 February, 2000 Installing Windows NT 4.0 Workstation at Home

Create Microsoft Office 97 Folder for Start Menu
The installation of Office 97 puts the shortcuts for its programs into the Programs folder for the All
Users section of the Start Menu, instead of creating a separate Microsoft Office 97 folder for these
shortcuts. Here we correct for this ‘misbehaviour’ and create a folder ourselves.

• Right-Click the Start button on the taskbar to open the context menu,
Select Explore All Users

• Select the Programs folder of the All Users Profile in the All folders pane at the left
(C:\Winnt\Profiles\All Users\Start Menu\Programs)

• Right-Click in the Contents of ‘Programs’ pane at the right to open the context menu
Select New ► Folder
Specify the folder’s name: Microsoft Office 97
Press Enter to accept the new name

• Move the Office shortcuts to the new folder:
Left-Click Microsoft Access
Shift+Left-Click Microsoft Word
Right-Click Microsoft Word to open the context menu and select Cut
Right-Click the Microsoft Office 97 folder to open the context menu and select Paste

• Continue with next section

Remove New Office Document and Open Office Document from the Start Menu
• Select the Start Menu folder of the All Users Profile in the All folders pane at the left

(C:\Winnt\Profiles\All Users\Start Menu)

• In the Contents of … pane at the right:
Left-Click New Office Document
Ctrl+Left-Click Open Office Document
Right-Click Open Office Document to open the context menu,
Select Delete
Press Enter to confirm deletion

MS Office 97 Proofing Tools
Install Language Packs for Dutch and German.

• Insert  MS-Office 97 Proofing Tools CD into CD-ROM drive
The installation program starts

• Press Annuleren to cancel installation of Microsoft Internet Explorer

• Close the Internet Explorer that appears

• Start | Run: E:\Dutch\Setup.exe

• Press Enter to confirm Welcome message and continue

• Press Enter to Install Dutch Proofing Tools

• Press Enter to accept the default selection for Tools
installing...

• Press Enter to confirm the Setup Successful message and continue

• Press Enter to accept the setting for Default Language

• Press No to confirm to Your default language settings were not changed message and skip
viewing the manual

• Following a similar procedure, install the German language pack
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• Start | Run: E:\German\Setup.exe

Office Service Release and Security Patches
Now install Office 97 Service Release 2b and two security patches.

• Insert the Y2k r4 CD into the CD-ROM drive

Office 97 Service Release 2b
• Start | Run: E:\apps\office97\sr2bof97.exe

• Press Enter to confirm to Do you want to install Microsoft Office97 SR-2b? message

• Press Yes to accept License Agreement
installing...

• Enter Product ID number: 63853-270-5101876-02460
Press Enter to continue

• Press Enter to confirm the All Microsoft Applications must be shut down message

• Press Enter to confirm the Microsoft Office97 SR-2 completed successfully message

• Press Enter to confirm to Restart computer now?

Office 97 forms security patch:
• Start | Run: E:\apps\office97\fm2paste.exe

• Press Enter to confirm the Install Microsoft Forms 2.01 message

• Press Yes to accept the License Agreement
installing…

• Press Enter to confirm the Microsoft Forms 2.01 was installed successfully message

Word 97 template security patch:
• Start | Run: E:\apps\office97\wd97sp.exe

• Press Enter to confirm the Install Microsoft Word 97 Security Patch message

• Press Yes to accept the License Agreement
installing…

• Press Enter to confirm the Microsoft Word has been patched successfully message

4.8. Corel Suite 8
text text.

4.9. CorelDraw 8
text text.

4.10. GS Tools
GSview is a graphical interface for Ghostscript. Ghostscript is an interpreter for the PostScript
page description language used by laser printers.

Install GS Tools
• Insert the Biophysics Proto CD into the CD-ROM drive

• Start | Run: E:\gs\gs32\gsv27550.exe

• Press Enter to start setup
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• Press Enter to confirm the GSView install message

• Press Enter to confirm the GSView Copyright Notices

• Press Enter to accept the components to install

• Press Enter to accept the default installation directory (c:\gstools)

• Press Enter to create the c:\gstools directory

• Press Enter (Finish) to create the GSView Start Menu item

• installing…

• Close the GSTools Program Folder

• Press Enter to exit the installation program

Configure GSView
• Start | Programs | GS Tools | GSview

• Press Enter to confirm message

• Press Enter to accept configuration default settings

• Press Enter to update the GSview printer list

• Press Enter to accept file associations ( .eps .ps, not .pdf )

• Press Enter to create Start Menu item

• Press Enter to finish configuration

• Close the GS Tools Program Folder

• Press Enter to exit the configuration program

• Close GSview

4.11. MiKTeX
MiKTeX is a free TeX distribution for Windows 95/98 and Windows NT.

Install MiKTeX
• Insert the Biophysics Proto CD into the CD-ROM drive

• Start | Run: E:\miktex\complete.exe

• Press Enter to confirm the message This will install MikTeX1.11

• Press Enter to confirm the Welcome message

• Press Enter to accept the default Destination Location

• Select Custom Setup Type and press Enter to continue

• Press Next to accept the default Components selection

• Press Enter to accept the default Local TEXMF Root Directory

• Press Enter to accept none preexisting TEXMF trees

• Press Enter to accept default MikTeX Program Folder

• Press Enter to confirm Check Setup Information message

• Installing…
Creating LaTeX formats

• Press Enter to confirm the Refresh Filename Database warning message
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• Press Enter to confirm the Autoexec.bat has been modified warning message

• Press Enter to Finish setup

Create Format Files
• Double-click clock on taskbar to set computer date back to 1998

• Start | Programs | MiKTeX | Maintenance | Create All Format Files

• Start | Programs | MiKTeX | Maintenance | Create LaTeX Format File

4.12. WinEdt
WinEdt (shareware) is a powerful, extremely flexible and versatile native editor and shell for
MS Windows with a strong predisposition towards the creation of [La]TeX documents.

Install WinEdt
• Insert the Biophysics Proto CD into the CD-ROM drive

• Start | Run: E:\miktex\winedt32.exe

• Press Enter to accept Unzip files to C:\TEMP
Press Enter to confirm message

• Press Enter to Close WinZip Self-Extractor

• Start | Run: C:\TEMP\144MB\Disk1\Setup.exe

• Press Enter to confirm Welcome message

• Press Enter to accept License Agreement

• Press Enter to confirm Readme Information

• On the User Information screen:
Accept default Name and Company
or
Specify Name: Name
Specify Company: Company
and
Press Enter to accept information

• Press Enter to accept default Destination Location
(C:\Program Files\WinEdt)

• Select Custom Setup Type
Press Enter to accept this setting

• Press Enter to accept Component Selection and Destination Directory

• Press Enter to accept default Program Folder (WinEdt)

• Press Enter to confirm Start Copying Files

• Installing…

• Press Enter to Finish installation

• Close the WinEdt Program Folder

Install WinEdt License
• Start | Programs | WinEdt | WinEdt

• Select Register from the Help menu
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• On the Registration Data dialog box
Specify Name: Peter Gast
Specify Code: 65136681
Press Enter to accept this information

• Close WinEdt

Remove Icon from Desktop
• Select the WinEdt icon on the desktop and put it in the Recycle Bin.

Remove WinEdt shortcut from All Users Profile
• Right-Click the Start button on the taskbar to open the context menu,

Select Explore All Users

• Select the Start Menu folder of the All Users Profile in the All folders pane at the left
(C:\Winnt\Profiles\All Users\Start Menu)

• In the Contents of pane at the right:
Right-Click WinEdt to open the context menu
Select Delete
Press Enter to accept deletion

4.13. MatLab 5.3
• Insert the MatLab 5.3R11.1 CD into the CD-ROM drive

the installation program starts

• Press Enter to confirm the Welcome message and continue

• Press Enter to accept the Software License Agreement

• On the Customer Information screen:
Specify Name: Name
Specify Company: Company
Specify Personal License Password: 11-25031-33344-41184–55069
Press Enter to accept the information and continue

• Press Enter to accept the default MATLAB Components and Destination Directory
(C:\MATLABR11)

• installing…

• On the Setup Complete screen:
Uncheck Yes, launch the Help Desk to view the Release Notes
Uncheck Yes, launch MATLAB
Press Enter to Finish

Remove Icon from Desktop
• Select the MATLAB 5.3 icon on the desktop and put it in the Recycle Bin.

4.14. Origin 5.0
First we install Origin 5.0. Then we have to move the Microcal Origin program folder from the
Administrator Profile to the All Users Profile. Further the security settings of the program folder
have to be corrected to enable users to use it.

Setup Microcal Origin 5.0
• Insert the Biophysics Proto CD into the CD-ROM drive
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• Start | Run: E:\origin\origin5\setup.exe

• Press Enter to confirm Welcome message

• Press Enter to accept License Agreement

• On the User Information dialog box:
Specify Name: Name
Specify Company: Company
Specify Serial: G43S5-9478-7053946
Press Enter to accept this information

• Press Enter to confirm the Registration Information

• Press Enter to accept the Typical Setup type

• Press Enter to accept the default Destination Directory (C:\Origin50)

• Press Enter to accept the default Program Folder (Microcal Origin)

• Press Enter to confirm to the Start Copying Files dialog box
installing…

• Custom Disk dialog box appears
Press Enter to accept default – no custom disk – and continue

• Setup finishes installation

• Press spacebar to uncheck to skip viewing Readme file
Press Enter to Finish Setup

• Close the Microcal Origin Program Folder window

Move Microcal Origin 5.0 Program Folder
• Right-Click the Start button on the taskbar to open the context menu,

Select Explore All Users

• Select the Programs folder of the Administrator Profile in the All folders pane at the left
(C:\Winnt\Profiles\Administrator\Start Menu\Programs)
The Microcal Origin program folder is now visible in the right pane

• Right-Click Microcal Origin to open the context menu,
Select Cut

• In the All folder pane at the left scroll to the Programs folder of the All Users Profile and select
it (C:\Winnt\Profiles\All Users\Start Menu\Programs)

• In the right pane Right-Click to open the context menu and select Paste
continue with the next section

Correct Microcal Origin 5.0 Program Folder Security Setting
• In the right pane Right-Click the Microcal Origin folder to open the context menu and select

Properties

• On the Properties screen:
Select the Security Tab

• On the Security screen:
Press Enter to open the Directory Permissions dialog box

• In the Directory Permissions dialog box
Select Administrator (not Administrators) and Press Remove
Press Add… to add Everyone
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• In the Add Users and Groups dialog box
Select Everyone and press Add
Press Enter to accept the new settings

• Press OK on the Directory Permissions dialog box to accept the new settings

• Press OK on the Properties screen to close it

4.15. Programmers File Editor
Programmers File Editor is a large-capacity, multi-file editor Although it's primarily oriented
towards program developers and contains features like the ability to run compilers and
development applications, it also makes a very good general purpose editor for any function at all.

First we install the program and then we create a program folder for it.

Install Programmers File Editor
• Insert the Biophysics Proto CD into the CD-ROM drive

• Open a Windows NT Explorer: Start | Programs | Windows NT Explorer

• Double-Click: E:\pfe\pfe101i.zip
Press I Agree to accept WinZip license agreement

• Press Extract
Specify the Extract to folder: C:\Program Files\Pfe

• Press Enter to Extract the files

• Close WinZip

Create Start Menu Folder in All Users Section
• Right-Click the Start button on the taskbar to open the context menu,

Select Explore All Users

• Select the Programs folder of the All Users Profile in the All folders pane at the left
(C:\Winnt\Profiles\All Users\Start Menu\Programs)

• Right-Click in the Contents of ‘Programs’ pane at the right to open the context menu
Select New ► Folder
Specify the folder’s name: Programmers File Editor
Press Enter to accept the new name

• Now in the All folders pane at the left:
Select the Programmers File Editor folder in the Program Files subdirectory
(C:\Program Files\Pfe)
The Programmers File Editor files are now visible in the right pane

• Left-Click Pfe.hlp
Ctrl+Left-Click Pfe32.exe
Right-Click Pfe32.exe to open the context menu,
Select Copy

• In the All folder pane at the left scroll to the Programmers File Editor folder of the All Users
Profile and select it

(C:\Winnt\Profiles\All Users\Start Menu\Programs\Programmers File Editor)

• In the right pane Right-Click to open the context menu and select Paste Shortcut

• Rename Shortcut to Pfe.hlp to Online Manual
Rename Shortcut to Pfe32.exe to Programmers File Editor

(Right-Click file, select Rename and specify new name)
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5. Preparing the Default User Environment
Now we will prepare the user environment for the accounts that we will create later on. First we
create an account to configure. When all configuration has been done, we copy the settings to the
Default User Profile.

Create the default Account

Windows NT Taskbar

Icons on the Desktop

Programs Menu
• move Administrative Tools (Common) from All Users to Administrator Profile

Saving the Result
• logout, logon again as default

6. Creating the User Accounts
Now the accounts for the users of your computer can be created. See C. How to Create a User
Account.

7. Finishing

Defragment drives
• Manual defragmentation

• Boot-time defragmentation

Configure Diskeeper (Optional)
You can configure Diskeeper to take action according to a schedule or run it manually.

• Start | Programs | Executive Software | DiskeeperWorkstation | Diskeeper

• Uncheck Show this screen at startup and press Close to continue

• Select Set It and Forget It from the Action menu
Select a partition and specify a schedule you find appropriate
Press Start to activate the schedule

• Close Diskeeper by Clicking the close button [X] at the right of the window.

A. What You Need
Here is a checklist of what you (may) need.

• Floppies (3) with Windows NT 4.0 Workstation Setup
(only if not able to set the BIOS to start from CD-ROM)

• [Floppy with driver for CD-ROM drive]

• Floppy with driver for Mouse

• Floppy with Partition Magic

• n Empty 3.5” floppies
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• CD Windows NT 4.0 Workstation

• CD with driver for Video Card

• CD with driver for Printer

• CD with driver for Modem

• CD Y2k r4

• CD Diskeeper 5.0

• CD Microsoft Office 97

• CD MS Office 97 Proofing Tools

• CD Corel WordPerfect 8 Suite

• CD CorelDraw 8

• CD Matlab 5.3 r11.1

• CD Biophysics Proto

B. How to Create the Windows NT Setup Floppies
Use the following procedure to create the three Windows NT 4.0 Workstation Setup floppies on a
computer with a CD-ROM drive.

Computer Runs MS-DOS or Windows 95/98
• Insert the Windows NT 4.0 Workstation CD into the CD-ROM drive

• C:\>D:\i386\winnt /ox

Computer Runs Windows NT 4.0
• Insert the Windows NT 4.0 Workstation CD into the CD-ROM drive

• C:\>D:\i386\winnt32 /ox

C. How to Create a User Account
This section describes how you can create a user account.

• Logon as Administrator

• Start the User Manager:
Start | Programs | Administrative Tools (Common) | User Manager

• User Manager screen appears

• Select New User… from the User menu

• On the New User dialog box:
Specify Username: accountname
Specify Full Name: Initials Name
Specify Description: User
Specify and confirm password: xxxxxx
Uncheck: User Must Change Password at Next Logon
Press Profile to open the User Environment Profile dialog box

• On the User Environment Profile dialog box:
Specify Home Directory, Local Path: D:\accountname

Press Enter to accept this information
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• Press Enter to accept information and create account.

• Select Exit from the User menu to leave User Manager.

Now the account has been created with the user environment for the default user.


